LENESANS Release Note

RZ/T2H Group

Encoder I/F SSI sample program

Summary
This document describes the RZ/T2H Encoder I/F SSI sample program package.

For Synchronized Serial Interface (SSI) communication protocol specifications and encoder specifications,
contact manufacturer of each encoder to obtain it.

Functionality Checked Device
RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)
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RZ/T2H Group Encoder I/F SSI sample program

1. Package Contents

This package contains the following contents.
The RZ/T2H encoder interface supports up to 16 axes, but the sample program uses only 1 axis of them. If

you use with 2 axes or more simultaneously, modify the sample program to support required axes.

1.1 Software
e Source code

No. name Version
1 RZ/T2H SSI sample program (CR52 ver. *) 3.0
2 RZ/T2H SSI sample program (CA55 ver. *) 3.0

Note: This sample program has a CR52 version that runs on the CPU core Cortex-R52 and a CA55 version
that runs on the CPU core Cortex-A55. CR52 ver. and CA55 ver. are descriptions of the respective
version.

1.2 Document

No. Document name Version File name
1 RZ/T2H Group Encoder I/F SSI 3.00 (j) r11an0806j0300-rzt2h.pdf
sample program Release Note (e) r11an0806€j0300-rzt2h.pdf (this document)
2 RZ/T2H Group SSI sample 3.00 (j) r11an0805jj0300-rzt2h-ssi.pdf
program Application Note (e) r11an0805ej0300-rzt2h-ssi.pdf
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RZ/T2H Group Encoder I/F SSI sample program

2. File Structure

The file structure and contents of this package are detailed below.
Top
— r11an0806jj0300-rzt2h.pdf

F— r11an0806ej0300-rzt2h.pdf
L— workspace

— Software

| — iccarm

| | F— RZ_T2H_CR52_ssi.zip : RZ/T2H SSI sample program set
| | | CR52 ver. (IAR)

| | L— RZ_T2H_CA55_ssi.zip : RZ/T2H SSI sample program set
| CA55 ver. (IAR)

| — gee

| F— RZ_T2H_CR52_ssi.zip : RZ/T2H SSI sample program set
| | CR52 ver. (e2 studio)

| L— RZ_T2H_CA55_ssi.zip : RZ/T2H SSI sample program set
|

CADB55 ver. (e? studio)
L— Documents

F— r11an0805jj0300-rzt2h-ssi.pdf

L— r11an0805ej0300-rzt2h-ssi.pdf

The file structure of the RZ_T2H_CR52_ssi.zip and RZ_T2H_CA55_ssi.zip is shown below.

Top folder
— configuration.xml : FSP configuration data
— ( Environment File Depending on Build Tool )
L— src
— hal_entry.c : SSI sample program
F— ssi_main.c : SSI sample program
— siochar.c : SCI_UART sample program
— siorw.c : SCI_UART sample program
— sio_char.h : SCI_UART sample program
L— drv
L— ssi
— iodefine_ssi.h : SSI register definition file
F— r_ssi_rzt2.c : SSI driver file
F— r_ssi_rzt2_config.h : SSlI driver file
F— r_ssi_rzt2_dat.h : SSI driver file
L— r_ssi_rzt2_if.h : SSlI driver file
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RZ/T2H Group Encoder I/F SSI sample program

3. About SSI sample program

This section contains information necessary to use the complete set of SSI sample program.

3.1 Software Information

3.1.1 Base OS
This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program and SSI driver is shown in the following table. This table does not
include memory size used by Flexible Software Package or C language libraries of the compiler.

(1) CR52 ver.

ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
SSI driver Code 3.7 3.0
Data (with initial value) 0.0 0.0
Data (without initial value) 2.8 2.8
Constant Data 0.2 0.2
Sample program Code 4.2 4.7
Data (with initial value) 0.0 0.0
Data (without initial value) 0.5 0.6
Constant Data 14 1.8

(2) CADS55 ver.
ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
SSI driver Code 5.1 4.3
Data (with initial value) 0.0 0.0
Data (without initial value) 29 3.1
Constant Data 0.3 04
Sample program Code 71 7.9
Data (with initial value) 0.0 0.0
Data (without initial value) 0.5 0.6
Constant Data 1.6 1.7
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RZ/T2H Group Encoder I/F SSI sample program

3.2 Hardware Information
3.2.1 Device
RZ/T2H

3.2.2 Target Board
(1) Board Name

RZ/T2H Evaluation Board (RTK9RZT2H0C00000BJ)

(2) Setting of the Target Board
The target board configuration is as follows.
SW1-4: ON
SW1-6: OFF
SW2-1: ON, SW2-2: OFF
SW2-7: OFF
SW2-8: OFF
SW14-1: ON, SW14-2: OFF, SW14-3: ON, SW14-6: OFF (Set xSPI1 boot mode)
CN39: Short between 2-3 pins (Set VDD1833_2 to 3.3 V)
CN40: Short between 2-3 pins (Set VDD1833_3 to 3.3V)

CN78: Short between 1-2 pins, Open between 3-4 pins, and between 5-6 pins (Set VDD1833_6 to 3.3V)

R11ANOSOGEJ0300 Rev.3.00
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Encoder I/F SSI sample program

(3) Used Pins of the Target Board

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as

follows.
Channel Pin name Pin header | Input/Output Voltage Description
domain
SSI0 ENCIFDIOO (SLO) CN2 #9 Input VDD33 Data input
ENCIFCKO00 (MAO) CN2 #3 Output vVDD33 Clock output
SSI1 ENCIFDIO1 (SL1) CN2 #8 Input VDD1833_3 Data input
ENCIFCKO01 (MA1) CN2 #2 Output VDD1833_3 Clock output
SSI2 ENCIFDIO2 (SL2) CN2 #17 Input VDD33 Data input
ENCIFCKO02 (MA2) CN2 #11 Output vVDD33 Clock output
SSI3 ENCIFDIO3 (SL3) CN2 #18 Input VDD33 Data input
ENCIFCKO03 (MA3) CN2 #12 Output VDD33 Clock output
SSl4 ENCIFDIO4 (SL4) CN2 #27 Input VDD1833_5 Data input
ENCIFCKO04 (MA4) CN2 #21 Output vVDD33 Clock output
SSI5 ENCIFDIO5 (SL5) CN2 #26 Input VDD1833_6 Data input
ENCIFCKO05 (MA5) CN2 #20 Output VDD1833 6 Clock output
SSI6 ENCIFDIO6 (SL6) CN3 #9 Input VDD1833_3 Data input
ENCIFCKO06 (MAG) CN3 #3 Output VDD1833_3 Clock output
SSI7 ENCIFDIO7 (SL7) CN3 #8 Input VDD1833_3 Data input
ENCIFCKO7 (MA7) CN3 #2 Output VDD1833_3 Clock output
SSI8 ENCIFDIO8 (SL8) CN3 #17 Input VDD33 Data input
ENCIFCKO08 (MAS8) CN3 #11 Output vDD33 Clock output
SSI9 ENCIFDIO9 (SL9) CN3 #18 Input VDD1833_2 Data input
ENCIFCKO09 (MA9) CN3 #12 Output VDD1833_2 Clock output
SSIM0 ENCIFDI10 (SL10) CN3 #27 Input VDD1833_2 Data input
ENCIFCK10 (MA10) CN3 #21 Output VDD1833_2 Clock output
SSI11 ENCIFDI11 (SL11) CN3 #26 Input VDD1833_2 Data input
ENCIFCK11 (MA11) CN3 #20 Output VDD1833_2 Clock output
SSIM2 ENCIFDI12 (SL12) CN10 #9 Input VDD1833_6 Data input
ENCIFCK12 (MA12) CN10 #3 Output VDD1833_6 Clock output
SSI13 ENCIFDI13 (SL13) CN10 #8 Input VDD1833_6 Data input
ENCIFCK13 (MA13) CN10 #2 Output VDD1833_6 Clock output
SSi14 ENCIFDI14 (SL14) CN10 #17 Input VDD33 Data input
ENCIFCK14 (MA14) CN10 #11 Output vDD33 Clock output
SSI15 ENCIFDI15 (SL15) CN10 #18 Input VDD33 Data input
ENCIFCK15 (MA15) CN10 #12 Output VDD33 Clock output
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3.3 Procedures on Development Environments: CR52 ver.

3.3.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select higher-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM: IAR Systems
(1) Build Environment

IAR Embedded Workbench for ARM (EWARM)

Version 9.60.3 + patch (EWARM_Patch_for RZT2H N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2025-04.1
RENESAS Flexible Software Package (FSP) for RZ/T2 v3.0.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_T2H_CR52_ssi.zip and copy the extracted source files to the desired location.
Activate EWARM

Select [File] menu -> [Open Workspace].

Open the extracted source file RZ_T2H_ssi.eww

Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

a b wN

Note The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS$
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.

R11ANOB0BEJ0300 Rev.3.00 Page 7 of 15
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In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

!E C¥1_Prog¥Work¥Work_C¥Work_EWA_960_3_fsp3.0.0¥RZT2H_55|_release_chk - FSP Smart Configurator — [m] x |
File Window Run Help
[RZT2H_SSI_release_chk] FSP Configuration X e " FSP Visualization = a
o
Summary Generate Project Content 'r'
Project Summary ~
RENESAS
Board: RZT2H Evaluation Board (RAM execution without flash memory) ®
Device: ROAD9GOT7MA4GBG
Core: CRS52 CPUO
FSP Version: 3.0.0
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_EWA_960_3_fsp3.0 0/RZT2H_SSI_release_chk
Selected software components
Board Support Package Common Files v3i0o
Memory Config Checking v3.0.0
/0 Port v300 3
Summary BSP Clocks Pins | Interrupts Event Links Stacks Components » AL
[ Properties [%] Problems | = 0 B Console = e
No consoles to display at this time.

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_T2H_ssi.out is generated.

(4)

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

Sample Program Execution Procedure

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

()

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group SSI Sample Program Application Note.
¥ COM10 - Tera Term VT

TP IF) (5 I+O-JLQ)
rt

Execution Result of the Sample Program

DAAEIW)  ALTH)
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RZ/T2H Group
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3.3.3 e?studio: RENESAS
(1) Build Environment

RENESAS e? studio 2025-04.1
Toolchain version: GNU ARM Embedded 13.3.1.arm-13-24
RENESAS Flexible Software Package (FSP) for RZ/T2 v3.0.0

(2) Execution Environment ICE
SEGGER J-Link™ v8.30

(3) Build Procedure of the Sample Program

The procedure for building the sample program is as follows.

1 Extract RZ_T2H_CR52_ssi.zip and copy the expanded source file to the desired location.
2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select

Existing projects into workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root

directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].
5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

Q RZT2H_SSI_release_chk - £ studio
File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help
LR LRE- R B4

Project Explorer e

~ 155 RZ_T2H_ssi
il Includes

P
1o¢ configuration.xml '
' _12H_ssi Debug_Fatjlink

¥| RZ_T2H_ssi Debug_Flatlaunch

2) Developer Assistance Prablems X Console Properties Smart Browser
0 errors, 11 wamnings, ) others
Description Resource Path
5 Warnings (11 items)

— [m] >

Q e8| EEcces
= 0O Qutline X =50 .

)
There is no active editor L
that provides an outline.

Smart Manual 8 B

Location Type

R11ANOSOGEJ0300 Rev.3.00
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RZ/T2H Group Encoder I/F SSI sample program

6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rzt, rzt_cfg, rzt_gen, script and .settings folders are generated.

B RzT2H SSI_release_chk - RZ_T2H_ssi/configuration.xml - &% studio - u] x
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help
TR o it Q- Q B+
Project Explorer = [RZ_T2H_ssil FSP Configuration 3 Outline AAac=n0
= Summary 0o There is no active editor that 2z
v 155 RZ_T2H_ssi Generate Project Content | provides an outline
ai) Includes
- Project Summary ~
RENESAS
configurationxml
RZ.T2H_ssi Debug_Flatjlink Boaf-a, RZ;ZHFE\;BI\PJ?;ZEH Board (RAM execution without flash memory)
2| RZ_T2H_ssi Debug Flatlaunch | DeVIce: RAADGG77MAACHG
Core: CR52 CPUO
7) Developer Assistance 2} .
Toolchain: GCC for Renesas RZ
Toolchain Version: 13.3.1.arm-13-24
FSP Version: 300
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_E2S_RZ../RZT2H_SSI_release_chk/RZ_T2H_ssi ==
Selected software components
Board Support Package Common Files v300
Memory Config Checking v3.00
VO Port v300 i
Summary | BSP| Clacks| Pins | Interrupts| Event Links | Linker Sections | Stacks| Components
Problems Console Properties Smart Browser Smart Manual =B
0 errors, 11 wamings, 0 others
Description Resource Path Location Type
i Warnings (11 items)
< >

7 Select [Project] menu -> [Build All]
The Debug\RZ_T2H_ssi.elf file is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure”, connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading to internal RAM.
3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group SSI Sample Program Application Note.

¥ COM10 - Tera Term VT - m] X
JrAIF)  RWEE) (S) IvFO-IO)  FHUEIW)  ALTH)

rt ~
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3.4 Procedures on Development Environments: CA55 ver.

3.4.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select lower-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.4.2 EWARM: IAR Systems
(1) Build Environment

IAR Embedded Workbench for ARM (EWARM)

Version 9.60.3 + patch (EWARM_Patch_for RZT2H N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2025-04.1
RENESAS Flexible Software Package (FSP) for RZ/T2 v3.0.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_T2H_CA55_ssi.zip and copy the extracted source files to the desired location.
Activate EWARM.

Select [File] menu -> [Open Workspace].

Open the extracted source file RZ_T2H_CA55_ssi.eww.

Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

a b wN

Note The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS$
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.

R11ANO806EJO300 Rev.3.00
Sep 19.25
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RZ/T2H Group Encoder I/F SSI sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

m C:¥1_Prog¥Work¥Work_C¥Work EWA_960_3 fsp3.0.0¥RZT2H_SSI_CASS release_chk - FSP Smart Configurator - [m] x ‘
File Window Run Help
[RZT2H_S5I_CAS5_release_chk] FSP Configuration % FSP Visualizatior = 0
()

Summary Generate Project Content L]

Project Summary A

RENESAS

Board: RZT2H Evaluation Board (RAM execution without flash memory) -

Device: RIADSGO7T7M44GBG

Core: CAB5 Cored

FSP Version: 300
Project Type: Flat
Location: C:/1_Prog/Work/Work_G/Work_EWA_96_p3 0 0/RZT2H_SSI_CAS5_release_chk

Selected software components

Board Support Package Common Files v300
Memory Config Checking v3.0.0
1/ Port v3.0.0 M
Summary BSP| Clocks  Pins | Interrupts | Event Links Stacks| Components » AF

#§ 0 B console ==

No consoles to display at this time.

[ Properties |2 Problems

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\ RZ_T2H_CAS55_0_ssi.out is generated.

(4) Sample Program Execution Procedure

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group SSI Sample Program Application Note.

¥ COMS - Tera Term VT - m] x
J7AIEF) (S) IXRO-IO) 2AUEIW)  ALTH)
rt
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RZ/T2H Group Encoder I/F SSI sample program

3.4.3 e?studio: RENESAS
(1) Build Environment

RENESAS e? studio 2025-04.1
Toolchain version: GCC ARM A-Profile (AArch64 bare-metal) 10.3.1.20210621
RENESAS Flexible Software Package (FSP) for RZ/T2 v3.0.0

(2) Execution Environment ICE
SEGGER J-Link™ v8.30

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_T2H_CAS55_ssi.zip and copy the expanded source file to the desired location.

2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing projects into workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

a RZT2H_5SI_CAS55 release_chk - € studio — (] * |
File Edit Source Refactor MNavigate Search Project RenesasViews Run Window Help

®-K - o i v Qur Q im By
Project Explorer < Lo | = 0O Outline X I mbl

= g There is no active editor that €8
“ 5 RZ_T2H_CAS55 0 ssi provides an outline.
m)) Includes

=¢ configuration.xml

RZ_T2H_CAS55_0_ssi Debug_Flat
K| RZ_T2H_CAS55 0 ssi Debug Flai
7) Developer Assistance Problems X Console Properties Smart Browser Smart Manual g = 0

0 errors, 11 warnings, 0 others
Description Resource Path Location Type
I Warnings (11 items)

R11ANOB0BEJ0300 Rev.3.00 Page 13 of 15
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6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rzt, rzt_cfg, rzt_gen, script and .settings folders are generated.

7 Select [Project] menu -> [Build All]
Files Debug\RZ_T2H_CA55_0_ssi.elf is generated.

(4) Execution Procedure of the Sample Program

) RzT2H_SSI_CASS_release_chk - RZ_T2H_CAS5_0_ssi/configurationaml - & studic ] x
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help
D&~ e ity Q- Q Egc/c++
Project Explorer X = B8 [RZ_T2H_CAS5_0_ssi] FSP Configuration X mmnlnlen  Outling X I =
= Summary There is no active editor that
v |25 RZ_T2H_CAS55_0_ssi Generate Project Content § provides an outline.
& Includes i
- Project Summary ~
RENESAS
configurationxml
RZ_T2H_CAS5.0_ssi Debug_Flatj Board.r RZT2H F\;ﬂh::l\:n Fl:ard (RAM execution without flash memory)
X RZ_T2H CASS 0_ssi Debug_Flaus | DEVICe: ROAOIGOTTMA4GEG
2) Developer Assistance Core: CAS5 Cored
- ° Toolchain: GCC for Renesas RZ (A-Profile AArch64 bare-metal)
Toolchain Version: 10.3.1.20210821
FSP Version: 300
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_E2S_RZ...A55_release_chk/RZ_T2H_CAS5_0_ssi <=
Selected software components
Board Support Package Common Files v3.00
Memory Config Checking v3.00
O Port v300 ||
Summary | BSP| Clocks | Pins | Interrupts| Event Links | Linker Sections | Stacks| Companents
Problems Console Properties Smart Browser Smart Manual =0
0 errors, 11 warnings, 0 others
Description Resource Path Location Type
i Wamings (11 items)
< >

After executing the "build procedure”, connect the target board and debugger correctly, and perform the

following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].

2 Click [Debug] to start downloading to internal RAM.

3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group SSI Sample Program Application Note.

¥ COM - Tera Term VT - m] X
J74IF)

(S) IVRO-IO)  PUEIW) ALTH)
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.

- IAR Embedded Workbench is a registered trademark of IAR Systems.

- J-Link is a trademark of SEGGER Microcontroller GmbH.

- Arm and Cortex are registered trademarks of Arm Limited (or its subsidiaries) in the EU and/or elsewhere.
All rights reserved.

- Additionally all product names and service names in this document are a trademark or a registered
trademark which belongs to the respective owners.




Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1  October 2020)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2025 Renesas Electronics Corporation. All rights reserved.
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